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Geographic Information Systems (typically referred to as GIS) is a powerful science and
technology that allows us to synthesize many different datasets from different sources regarding
a geography of interest, explore and analyze those datasets, and turn them into information that
helps us make decisions or explain our world. Because of this, GIS is very valuable for people
and organizations considering restoration projects in that it can help them gather baseline
information about the landscape they are considering, develop a plan for areas to target, as well
as simply help them visualize how the landscape might be impacted by their efforts. Each year
a NGO called the Stewardship Network which focuses on networking everyone working to
steward land and water in the Great Lakes region holds a professional conference where GIS is
a hot topic at sessions discussing restoration work ranging from controlled prescribed fire burns,
native plant plantings, and invasive species inventorying and removal (see the agenda for this
January conference here).

This document will provide some basic steps toward getting you acquainted with a very popular
professional GIS software piece called ArcMap which is made ESRI, Inc. We will use some
basic GIS datasets about Matthaei Botanical Gardens to get a sense of how the botanical
gardens landscape has changed over time and perhaps how areas could be targeted for
restoration. There is a lot to know and learn about GIS science, technology, and software.
Many resources are available to members of the university community interested in this field. If
you would like to learn more these workshop slides are a good place to start.

Getting Started

If the folder C:\temp\restoration does not already exist, download and unzip this folder.

If it is not already opened, Launch ArcMap 10.3.1 and choose the Restoration.mxd document.
When ArcMap is opened there are by default menus and basic toolbars at the top, a “Table Of

Contents” on the left hand side where datasets will be added, and a Data Frame on the right
hand side where datasets will be viewed.
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Click on the Add Data button = = . and add the MBG_Boundary.shp dataset
.ﬂzl MBG_Boundary.shp

This dataset layer draws and represents the geographic boundary of the Matthaei Botanical
Gardens. Right-click on MBG_Boundary and choose Properties:


https://www.stewardshipnetwork.org/sites/default/files/2016_program_for_web_11.30.2015.pdf
https://docs.google.com/presentation/d/1TqijrkaW7DSdHUrubVo6ut4SX0nW6y5WME7ne5uLsso/edit#slide=id.p
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Display the properties of this layer

On the Symbology tab of the dialog box that appears, click on the Symbol itself. We will change
how the symbol draws so that there is “No Fill’, and so that the Outline Color of the boundary is
red and the Outline Width is 3pts thick, then click OK twice to close the boxes.
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Click on the Add Data button again and add the MBG2010Aerial tif ##MBG2010Aerial tif
This is an aerial orthographic image of our site in 2010 that can be used as a nice backdrop
map of the area (much like you access using Google Maps or Google Earth). Test out the zoom



tools and see if you can zoom in and pan to inspect areas within Botanical Gardens that you
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might be familiar with. = “{6 AR

Can you find the main conservatory? Can you find the site being prepared for community

gardens next to which the present day Campus Farm now exists? Can you find other sites you
visited during this class?

Click on the Add Data button again and add the MBG_5ftContour.shp and the
MBG_Hydrology.shp datasets (you can use the shift button to select two datasets or more at
once to add). Change the symbol colors for the contour lines to a light gray and the symbol
colors for the hydrology to blue. The contour lines represent the terrain of the overall region.
When the lines are tightly spaced the area has a steep slope and when the lines are wider apart
the area has a more gradual slope. Do these contour lines remind you of the terrain you saw
when you were on the ground at the botanical gardens? The hydrology polygons represent the
river, ponds, and lakes in the area. Hopefully these also remind you of what you saw when at
the botanical gardens. Turn these dataset layers off for now as we will focus on something else
for the time being. You can turn layers off by simply unchecking the box next to them: i.e.

MBG_Hydrology [0 MBG_Hydrology
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Click on the Add Data button and add the MBG_1800_Landcover.shp dataset. This is a unique
dataset that was developed for the State of Michigan. Interpolating from notes that were
regularly recorded by surveyors as they surveyed the land in Michigan territory for the newly
formed United States, a reasonable map representation of what the landcover must have looked
like circa the year 1800 was created. This map exists for the whole state but using the
MBG_Boundary layer we have “clipped” that map down to just the polygon features that occur
within the botanical gardens. Consequently, the polygon features that have drawn before you
represent contiguous “clumps” of the landcover that likely existed in those areas in 1800. Try

out the Identify too by clicking on its buttonl and then clicking the cursor on one of the
polygon features that was just loaded. The polygon feature will flash momentarily and then the
report dialog box from the Identify tool will appear.
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The Identify tool reports back the attributes associated with the polygon feature that was click.
In the example above we can see that the polygon feature that was clicked has an 1800
COVERTYPE of OAK-HICKORY FOREST and an AREA of 5174871.87674 square feet (we
know it is square feet because of the projection of this dataset, which is something we will not
get into today).

These attributes are actually stored as columns (or fields) inside what is called an attribute table
that is linked to the polygon features of our dataset layer. You can see the attribute table by
right-clicking on MBG_1800_Landcover and choosing Open Attribute Table:
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The table that appears looks like below:

Table O x
MBG_1800_Landcover X
FID | Shape* | VEGCODE | LEGCODE COVERTYPE CNTY_NAME CREATE_UID CREATE_DTS UPDATE_UID UPDATE_DTS | GENERALIZE | RulelD RulelD_1 F_AREA
» 0 | Polygon 4122 4122 OAK-HICKORY FOREST | WASHTENAW | DNRRES_TAYLORG| 101162001 DMRRES\TAYLORG | 3/4/2002 4“ 0 1| S5174871.87674
1 | Polygon 4122 4122 OAK-HICKORY FOREST | WASHTENAW | DNRRES_TAYLORG| 101162001 DHRRES\TAYLORG | 3/4/2002 41 0 1| 4910941.75858
2 | Polygon 8227 B5226/622T7 | WET PRAIRIE WASHTENAW | DNRRES_TAYLORG| 10/16/2001 DHNRRES\TAYLORG | 3/5/2002 [ 0 1| 5601874.85093
3 | Polygon 332 332 BLACK OAKBARREN | WASHTENAW | DNRRES_TAYLORG| 101162001 =Mull= 3 0 1| 226029.551287
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MEBG_1800_Landcover

Using the information in this table you should be able to calculate the following:

What percentage of the modern-day botanical gardens area was Oak-Hickory Forest in 18007
What percentage of the modern-day botanical gardens area was Wet Prairie in 18007

What percentage of the modern-day botanical gardens area was Black Oak Barren in 18007?

Your GSI can explain in more detail what plant communities / landcover type is represented by
these COVERTYPE classes we are seeing with our 1800 landcover dataset.

We may wish to use the symbology capabilities of the software again to display our 1800
lancover polygon differently. Right-click on MBG_1800_Landcover again and go to Properties.
Under the Symbology tab on the left hand side under “Show:” click on Categories and in the
Value Field dropdown box choose COVERTYPE. Next click on Add All Values. Your dialog box
should end looking like below:
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Click OK and the new legend is applied to your data layer and the dialog box closes. You will
see the legend under Layers in the Table Of Contents as well as the depiction of the polygon

features that are drawn in the Data Frame have all changed accordingly. Now it is a little easier
to see the different landcover types at once and to verify that just a small portion of our botanical

gardens area was Black Oak Barren (hopefully our percentage calculation came out similar).

Now that we are familiar a bit with the landcovers of 1800 we might want to compare that to
other years. One of the first ways we can do that is by simply checking our
MBG_1800_Landcover layer on and off in order to see what the 2010 Aerial image shows us in
comparison. What are your initial impressions? Describe the areas of the 1800 Oak-Hickory
forest features that are no longer forested at all? There is at least one area that had trees in

2010 but they are coniferous trees i.e. definitely not oak-hickory deciduous trees. Where is that

area?

There are a few ways within ArcMap to try and look at multiple layers at once. One of the
simpler ones is to make your dataset layer semi-transparent. Right-click on



MBG_1800_Landcover and go to Properties. Choose the Display tab of the dialog box that
appears. Near the top, type in 40% for the Transparent amount and then click OK.
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Our polygon features have become semi-transparent and we can start to see Aerial image
below. Some people prefer to look at things this way instead of turning layers on and off
(although you may need to do a combination of things). You can adjust your Transparent
percentage amount if you would like to see how far you can go and still be able to retain the
color information associated with the COVERTYPE.

Adding More Landcover Layers from Different Years

Now that we are a bit comfortable with the way things have changed over time, let's add a few
more landcover polygon layers that represent the landcover in different years. Click on Add
Data and add the MBG_1978_Landcover.shp dataset layer. Using skills you've already tested
out adjust the symbology so you can better see the different polygon features for 1978. Try
under the Symbology tab to show Categories again using LABEL3 as the Value Field (and don’t
forget to Add All Values):
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You know have two polygon landcover layers for two different years. While the methodologies
that were used to create them are quite different, we can use them to make some general
comparisons and observations. Try turning layers on and off to compare. (Note: you can drag
layers to be in a different drawing order in your Table Of Contents if you prefer to adjust how
they draw.) What changes between 1800 and 1978 catch your eye? The 1978 polygon labeled
Lakes was what in 18007 What was the 1978 Herbaceous Rangeland polygon in 18007 There
is a 1978 Open and Other polygon just west of the Lakes polygon - what was it in 18007

Now add the MBG_2011_Landcover.shp dataset layer. It was created by hand digitizing
different landcovers identified in various datasets including aerial imagery. It has a lot more
detailed polygons. Adjust the symbology using CoverType as the Value Field. Can you find all
the 2011 Grassland polygons? If the Botanical Gardens was considering undertaking ecological
restorations on these grassland areas and wanted to restore them the landcover they were in
the early 1800s, what landcover type would you suggest be created for nearly all the 2011
Grassland polygons?

Making a Map



There are many different fine details that can be used in making a map within ArcMap. To make
a very basic map you just need to get the symbology colors that you want set and turn on the
layers you want to make visible. Then go the View pulldown menu and choose Layout View:
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The makings of a map have begun. If you would like to make a more advanced map,
experiment using the Insert pulldown menu you can insert basic map items like a Legend and
North Arrow. Once you have your Layout view set you can go under the File pulldown menu
and Export Map... (you can also just do a screen grab, snip, or capture). Choose either a .JPG,
.BMP or .EMF file format and you could easily bring your map image into Microsoft Word or
Google Docs to add text and any arrows etc. you would like to make your map more
understandable.

With the layers and skills at your disposal, create a map layout that highlights areas in the
Botanical Gardens that might be good candidates for an ecological restoration project to 1800
landcover types.



